Joystick Override GPI Input Interface
Model JOyVerride 20i-BMD
Designed to operate in conjunction with Blackmagic Design Videohub Routers

User manual

i. Safety & Compliance
• Safety issues
• EMC compliance statements
ii. Short-short version configuration
iii. Configuration (detailed)
• GPI inputs setup
• Setting the IP address of the Videohub router
• Setting the IP address of the JOyVerride interface
• Connecting the interface to a Wi-Fi network
iv. Connection methods
v. Technical summary
• Front & rear panel layout
• Specifications
vi. Appendix

JOyVerride 20i-BMD User Manual – Page 1 of 22

(i) Safety & Compliance
Safety issues

⚠

Important: this equipment must be plugged only into power outlets which
provide a working protective earth contact !

A suitable AC power cord is included in the JOyVerride package, with IEC 60320-1 C13 plug at one
end and a country-specific plug at the other end according to the location where the unit is
delivered.
Do not block the ventilation openings (in the left side) or the fan output opening (in the rear side).
The internal components and sub-assemblies radiates little heat, but even so, the ventilation has
been designed to ensure a proper air flow, as required for a trouble-free operation over a long period
of time.
Practice has proven that the product is very reliable, including during inherent frequent starts and
stops, as it happens, for example, when the unit is installed and operated on an O.B. Van; however,
there is still the theoretical possibility that the internal memory card may need to be replaced at
some point. If a service intervention is required, always unplug the AC power cord from the mains
power before removing the top cover.
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EMC Compliance Statements
Important: this product is intended to be operated only in commercial and industrial
environments.
European Union (EU) Electromagnetic Compatibility Directive Compliance Statement
This product is in conformity with the protection requirements of EU Council Directive
2004/108/EC on the approximation of the laws of the Member States relating to electromagnetic
compatibility.
This product has been tested and found to comply with the limits for Class A Information
Technology Equipment according to the European Standard EN 55022.

⚠

Warning: This is an EN 55022 Class A product. In a domestic environment this
product may cause radio interference, in which case the user may be required to
take appropriate measures.

United States (US) Federal Communications Commission Emissions Compliance Statement
This equipment has been tested and complies with the limits for a Class A digital device, pursuant to
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference when the equipment is operated in a commercial environment.
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) this device might not cause harmful interference, and (2) this device must accept any
interference received, including interference that might cause undesired operation.

⚠

Warning: operation of this equipment in a residential area is likely to cause
harmful interference, in which case the user will be required to correct the
interference at their own expense.

Industry Canada Class A Emissions Compliance Statement
This Class A digital apparatus complies with Canadian ICES-003.
Australia and New Zealand Class A Emissions Compliance Statement

⚠

Warning: This is a Class A product. In a domestic environment this product may
cause radio interference, in which case the user may be required to take
appropriate measures.
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(ii) Short-short version configuration
Connect to the JOyVerride interface by one of these methods:
•
•
•

directly to the interface, using a HDMI monitor and a USB keyboard (connect the HDMI
cable before starting the unit);
or
remotely from a nearby computer, using the RPi Console serial connection over USB & a
serial terminal installed on that computer (115200, 8N1);
or
remotely via SSH, if the network parameters are already set & known.

Use the current credentials to login. Default ones are:
user:
password:

pi
joyverride

To set up the JOyVerride interface IP address: edit the file /etc/dhcpcd.conf (with sudo) and either
uncomment (if previously commented out) & change accordingly the fields interface eth0, static
ip_address, static routers and (optionally) static domain_name_servers for a static IP requirement,
or comment out those fields (if previously uncommented) for a DHCP environment. Save the
changes and either stop & start or restart the networking service, or reboot.
To set up the Videohub router IP address: edit the file /home/pi/.bmd/joy_bmd_vh.ini and change
accordingly the IP value of the RTR_IP field in the DATA block. Save the changes and reboot *.
To configure the GPI inputs: edit the file /home/pi/.bmd/joy_bmd_vh.ini and follow the informations
provided inside the INFO block to learn how to edit the values inside the DATA block. Save the
changes and reboot *.
* Alternative to reboot, when setting up the Videohub router IP address or the GPI inputs:
stop the running JOyVerride program by keep pressing the front panel button for 5 seconds
until the message ‘JOyVerride closed on user request’ appears on the front panel display and
then enter python3 ~/joy/joyverride.py at the command prompt to restart the program.
Note: keep pressing the front panel button for more than 10 seconds will trigger a hardware
reset.
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(iii) Configuration (detailed)
Currently, setting the target IP address of the BMD Videohub router and the GPI input configuration
of the JOyVerride interface has to be done by manually editing a single plain text file stored in the
unit, while setting the JOyVerride interface own IP address has to be done in a Linux way
(Raspberry Pi OS is based on Debian).
This involves connecting to the unit by one of the following methods, as detailed in chapter (iv):
1. locally, using a text console directly from within the unit, by connecting to it a video
monitor equipped with HDMI input and then using a USB keyboard; a desktop environment
is also available, although this is not particularly necessary;
Note: when connecting a video monitor, the joystick interface must be turned ON after
connecting the HDMI cable (or restart/reset, if already ON), else the monitor output
circuit will not initialize.
or
2. using a serial terminal from a nearby computer, by means of the ‘RPi Console’ Mini USB
connector and a USB port on that computer;
or
3. using a SSH client from a remote computer, via network connection; a remote desktop
environment is also available over the network, although this is not particularly necessary.
The JOyVerride interface is delivered with TightVNC 1 desktop remote control server already
installed, therefore the Raspberry Pi OS desktop can also be viewed and used remotely; however,
the vncserver has to be initialized at each boot time with the desired display ID and virtual desktop
resolution, since currently this setting is not configured to be persistent.
Details on how to use one connection method or the other can be found in chapter (iv). Since the
configuration procedure is almost the same regardless of the connection method used, everything
that follows below is described without explicit reference to the physical connection method used.

Default credentials are:
user:
password:

pi
joyverride

Note: “pi” user is the default user and should not be changed.
To change the password, if so desired:
•
•
1

open a terminal window (if not already open) and use the current credentials to login (if not
already logged in);
enter passwd;

https://www.tightvnc.com/
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◦ you will be prompted to enter the current password and then to type and then retype the
new password.
Example of the procedure:
pi@joyverride-20i-bmd:~ $ passwd
Changing password for pi.
Current password:
New password:
Retype new password:
passwd: password updated succesfully
pi@joyverride-20i-bmd:~ $ █

Changing the password

Note: both current and new passwords are entered in blind.

The most handy way to edit the necessary configuration files (either ones) is to use the Nano
command-line editor that is installed by default in the Raspberry Pi OS. Although this editor may
seem rudimentary, it does the job very well for the present purpose.

GPI inputs setup
The GPI IN configuration is based on a plain text config file, which is located at the following
location:
/home/pi/.bmd/joy_bmd_vh.ini
Note: the .bmd is a hidden directory and is usually not viewed in simple directory listing;
while in command line mode, it can be listed with ls -a command; while in desktop mode, in
File Manager its visibility can be toggled by pressing Ctrl+H, or via File Manager menu >
View > Show Hidden; on the other hand, the hidden directories are displayed by default
when using SFTP in a Bitvise SSH Client session.
The configuration file format is as follows:
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JOY_BMD_VH
lang=en
BEGIN_INFO ====================================================================>
...
END_INFO ======================================================================<
BEGIN_DATA ====================================================================>
RTR_IP,172.16.30.50
RTR_PORT,9990
ALLOW_DST_LOCK,False
-,JOY_SRC_001,RTR_SRC_001
JOY_DST_001,RTR_DST_001
-,JOY_SRC_002,RTR_SRC_002
JOY_DST_002,RTR_DST_001
-,JOY_SRC_003,RTR_SRC_003
JOY_DST_003,RTR_DST_001
-,...
-,JOY_SRC_019,RTR_SRC_019
JOY_DST_019,RTR_DST_001
-,JOY_SRC_020,RTR_SRC_020
JOY_DST_020,RTR_DST_001
END_DATA ======================================================================<

Format of the configuration file.
Note: for the clarity of this reading, the content of the info block
and the configuration of GPI inputs 4-18 are not shown here.

The only useful user editable area is the data block between BEGIN_DATA and END_DATA tags.
Although the information presented in the file’s info block should be self explanatory, its essence is
detailed here as well.
Generally:
•
•
•
•
•

all data fields must remain in comma separated pairs format, without spaces in between;
-,- is just a visual separator; do not edit it;
all router sources and destinations must be specified with three digits, including for
numbers under 100 and 10
(e.g.: 001 for 1, 006 for 6, 039 for 39, 098 for 98, but 127 for 127, etc.);
router sources and destinations must be considered in human logic, i.e. starting with 1;
do not exceed the physical router size, i.e. do not specify source 017 for a 16x16 sized
router.

Then:
•
•

RTR_IP field is the IP address of the target BMD Videohub router. Just edit the IP value
right after the comma. The IP address is in IPv4 standard format.
RTR_PORT is the IP port of the Videohub router. Default port on BMD Videohubs is 9990,
but it would be a good idea to check this on your actual router.
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•
•
•
•

JOY_SRC_xxx are the joystick numbered inputs of the GPI IN connector of the joystick
interface. Do not edit it (this is only a numbered list, edit RTR_SRC_xxx instead – see
below).
RTR_SRC_xxx are the video router sources to be assigned to the corresponding GPI IN
connector of the joystick interface. Edit only the xxx value(s), where xxx = video router
source, in three digits format.
JOY_DST_xxx are the video router numbered destinations designated to be driven by the
joystick interface. Do not edit it (this is only a numbered list, edit RTR_DST_xxx instead –
see below).
RTR_DST_xxx are the video router destinations to be assigned to the corresponding GPI IN
connector of the joystick interface. Edit only the xxx value(s), where xxx = video router
destination, in three digits format.

Unused GPI inputs should remain as is, i.e. specified with whatever sources and destinations.
Example of a few configured GPI inputs (fragment):
-,JOY_SRC_001,RTR_SRC_011
JOY_DST_001,RTR_DST_002
-,JOY_SRC_002,RTR_SRC_012
JOY_DST_002,RTR_DST_002
-,...
-,JOY_SRC_014,RTR_SRC_001
JOY_DST_014,RTR_DST_008
-,JOY_SRC_015,RTR_SRC_002
JOY_DST_015,RTR_DST_008
-,JOY_SRC_016,RTR_SRC_003
JOY_DST_016,RTR_DST_037
-,JOY_SRC_017,RTR_SRC_004
JOY_DST_017,RTR_DST_037
-,JOY_SRC_018,RTR_SRC_018
JOY_DST_018,RTR_DST_001
-,...

Example of a few configured GPI inputs.
Note: for the clarity of this reading,
only GPI inputs 1-2 and 14-18 are exemplified.

In the above example:
•
•
•
•
•
•

GPI IN 1 will trigger video router source 11 to destination 2
GPI IN 2 will trigger video router source 12 to destination 2
GPI IN 3-13 are not shown here
GPI IN 14 will trigger video router source 1 to destination 8
GPI IN 15 will trigger video router source 2 to destination 8
GPI IN 16 will trigger video router source 3 to destination 37
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•
•
•

GPI IN 17 will trigger video router source 4 to destination 37
GPI IN 18 is supposedly not used in this example (but anyway, it defaults to video router
source 18 to destination 1)
GPI IN 19-20 are not shown here

To actually edit the GPI input configuration file:
•
•
•
•
•
•

open a terminal window (if not already open) and use the current credentials to login (if not
already logged in);
enter nano /home/pi/.bmd/joy_bmd_vh.ini
◦ this will open the joy_bmd_vh.ini file in edit mode, using Nano editor;
move the cursor inside the data block, i.e. between BEGIN_DATA and END_DATA tags;
edit the values according to the desired setup;
when happy with the edit, press Ctrl+X and then Y to save the changes and exit the Nano
editor;
enter sudo reboot to reboot the system.
Alternative to reboot: stop the running JOyVerride program by keep pressing the front
panel button for 5 seconds until the message ‘JOyVerride closed on user request’ appears
on the front panel display and then enter python3 ~/joy/joyverride.py at the command
prompt to restart the program.

Setting the IP address of the Videohub router
•
•
•
•
•
•

open a terminal window (if not already open) and use the current credentials to login (if not
already logged in);
enter nano /home/pi/.bmd/joy_bmd_vh.ini
◦ this will open the joy_bmd_vh.ini file in edit mode, using Nano editor;
move the cursor inside the data block, right under the BEGIN_DATA tag;
edit the IP address after the ‘RTR_IP,’ entry (i.e. right after the comma);
when happy with the edit, press Ctrl+X and then Y to save the changes and exit the Nano
editor;
enter sudo reboot to reboot the system.
Alternative to reboot: stop the running JOyVerride program by keep pressing the front
panel button for 5 seconds until the message ‘JOyVerride closed on user request’ appears
on the front panel display and then enter python3 ~/joy/joyverride.py at the command
prompt to restart the program.

If successful, after reboot the front panel display should confirm the connection:
Connected to Vid.hub
192.168.1.156
Example of the front panel display
when successfully connected to the target Videohub router
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Setting the IP address of the JOyVerride interface
By default, the unit is delivered with the DHCP mode turned ON, unless otherwise requested prior
to delivery. The unit IP and MAC addresses can be displayed on the front panel LCD, by short
pressing the small button located near its lower right corner; however, an IP address (either
statically defined or dynamically allocated) will be displayed only if the unit is actually connected
to a network and – in a DHCP environment – if a valid address has been successfully allocated by
the DHCP server.
Note: the MAC address of the network interface should also be found on a printed label on
the right side of the unit.
To turn the DHCP mode OFF and specify a static IP address of the network interface (i.e. Ethernet),
the file dhcpcd.conf must be edited as follows:
•
•
•
•

•
•

open a terminal window (if not already open) and use the current credentials to login (if not
already logged in);
enter sudo nano /etc/dhcpcd.conf
◦ this will open the dhcpcd.conf file in edit mode, using Nano editor;
go down near the end of the text, where it says ‘# Example static IP configuration:’;
uncomment the following lines – i.e. delete the # character in theirs front – and then adjust
the address values as needed (where ‘xxx.xxx.xxx.xxx’ is the required IP address):
◦ interface eth0
◦ static ip_address=xxx.xxx.xxx.xxx/xx
◦ static routers=xxx.xxx.xxx.xxx
◦ static domain_name_servers=xxx.xxx.xxx.xxx xxx.xxx.xxx.xxx
when happy with the changes, press Ctrl+X and then Y to save the changes and exit the
Nano editor
the network interface may require a restart; in order to do this, you may:
◦ disconnect and then reconnect the Ethernet cable;
or
◦ enter:
▪ sudo ifconfig eth0 down
▪ sudo ifconfig eth0 up
or
◦ enter sudo reboot to reboot the system;
Note: if, at anytime, you feel that something has been edited incorrectly or simply want to
quit without changing anything, press Ctrl+X and then N to exit the Nano editor without
making any changes to the file.

The dhcpcd.conf file provides address setting for both IPv4 and IPv6; however, the IP address of the
Videohub router as set within the JOyVerride interface can only be specified in IPv4 format; this,
combined with the fact that it is highly unlikely to run a broadcast intranet in other than IPv4
overall, it means that only IPv4 fields should be activated and edited here.
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The network mask (still IPv4) is specified in a prefix size form. For example, for a class C
255.255.255.0 mask, the value is /24 and must be written right after the IP address; likewise, for a
class B 255.255.0.0 mask, the value is /16 etc. You can find out more about this on the internet 2.
The domain name servers are more or less useless for the expected usage; however, if/when
entering the desktop mode, the Chromium Web Browser can be used for internet browsing, so for
that case alone the domain name addresses should be properly configured.
Example of dhcpcd.conf file edit (Nano editor snapshot while in PuTTY SSH session):
slaac private
# Example static IP configuration:
interface eth0
static ip_address=192.168.1.98/24
#static ip6_address=fd51:42f8:caae:d92e::ff/64
static routers=192.168.1.1
static domain_name_servers=192.168.1.1 8.8.8.8█
#fd51:42f8:caae:d92e::1
# It is possible to fall back to a static IP if DHCP fails:
# define static profile
#profile static_eth0
#static ip_address=192.168.1.23/24
#static routers=192.168.1.1
#static domain_name_servers=192.168.1.1
# fallback to static profile on eth0
#interface eth0
^G Get Help
^X Exit

^O Write Out ^W Where Is
^R Read File ^\ Replace

^K Cut Text ^J Justify
^U Uncut Text^T To Spell

^C Cur Pos
^_ Go To Line

Example of using Nano editor while editing the dhcpcd.conf file.
The lines that matter are coloured white, while the commented lines are coloured cyan.
Note: coloured lines are specific to native text console (when connected directly) or to SSH sessions;
if a serial terminal connection is used, then all lines are non-coloured (just white).

Check the front panel display by short pressing the small button located near its lower right corner;
the IP & MAC address of the eth0 should be reported right away (if connected):
JOyVerride IP eth0
192.168.1.98
MAC addr for eth0
b8:27:eb:dd:d7:2a
Example of the front panel display
when viewing eth0 IP & MAC address
(successive button press)

2

For example here https://www.calculator.net/ip-subnet-calculator.html
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Connecting the interface to a Wi-Fi network
The JOyVerride interface can also be connected over a wireless network, by connecting a Raspberry
Pi compatible Wi-Fi dongle to one of its USB ports and then by establishing a wireless connection
with the Wi-Fi router or access point which is on the same local network as the target Videohub
router.
Here, the term ‘compatibility’ refers to the chipset with which the Wi-Fi dongle was made. A few
chipsets are supported out of the box, notably RTL8188CUS from Realtek Semiconductor or
RT5370 from Ralink Technology (both being IEEE 802.11 b/g/n @ 2.4 GHz capable) 3.
Note: to find out the chipset used, insert the Wi-Fi dongle, enter lsusb at the command line
and look for a device that include the suffix ‘WLAN’ or ‘Wireless’.
There are two ways to connect to a wireless network: using the command line, or using the desktop
environment. If the SSID (the name of the wireless network) is precisely known, then using the
command line should be the easiest way to go; if unsure about the SSID or simply want to browse
all available networks, then the desktop mode is the way to go.
a) Using the command line mode:
•
•
•
•
•
•

open a terminal window (if not already open) and use the current credentials to login (if not
already logged in);
enter sudo raspi-config
go to Network Options > Wireless LAN;
enter the SSID when prompted;
enter the passphrase when prompted;
use the Tab key to go to <Finish> and exit the configuration tool.
Notes:
• in case no Wi-Fi dongle is present, then the message ‘No wireless interfaces found’
will appear when trying to enter the SSID;
• in case a Wi-Fi dongle is present but not recognized by the system (e.g. missing
drivers), then the message ‘Could not communicate with wpa_supplicant’ will appear
when trying to enter the SSID.

b) Using the desktop mode:
•

3

(using a physical connection)
◦ connect the JOyVerride interface to a video monitor via HDMI and – if switched OFF –
turn the interface ON, or – if already switched ON – turn the interface OFF and then ON
again;
◦ connect a USB keyboard and a USB mouse to the interface;
◦ open a terminal window (if not already open) and use the current credentials to login (if
not already logged in);

For more info regarding the USB compatible and/or recommended peripherals, please consult the Raspberry Pi &
Raspberry Pi OS documentation and the associated general information available on the internet.
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◦ enter startx
▪ (wait a bit for the desktop to show up)
or
(using a remote desktop session, if already on a wired network)
◦ use TightVNC client on a remote computer to connect to the desktop remotely;
Note: TightVNC is the recommended client as being the pair with the TightVNC
server already installed on the unit, but other VNC clients may work just as well.
•
•
•
•

hover the mouse over the two up/down arrows icon
in the upper right corner and wait
for the tooltip to appear;
◦ it should say ‘wlan0: Not associated’;
click the up/down arrows icon and select the desired wireless network;
enter the ‘Pre-shared Key:’ when prompted;
press Enter or click OK;
◦ if successful, the up/down arrows icon will change to a Wi-Fi icon
.
Notes:
• in case no Wi-Fi dongle is present, then the tooltip will not mention wlan0 at all, or –
if a Wi-Fi dongle was inserted at one point and then removed – it will say ‘wlan0:
Departed’ and the message ‘No wireless LAN interfaces found’ will appear when
clicking the up/down arrows icon;
• in case a Wi-Fi dongle is present but not recognized by the system (e.g. missing
drivers), then the tooltip will say ‘wlan0: Not associated’ and the message ‘No
wireless LAN interfaces found’ will appear when clicking the up/down arrows icon.

Check the front panel display by short pressing the small button located near its lower right corner;
the IP & MAC address of the wlan0 should be reported right after the IP & MAC address of the
eth0 (if connected), as in the following example:
JOyVerride IP wlan0
192.168.1.202
MAC addr for wlan0
40:a5:ef:03:1e:50
Example of the front panel display
when viewing wlan0 IP & MAC address
(successive button press)
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(iv) Connection methods
Connecting to the JOyVerride interface can be done by one of the following methods:
1. locally, using a text console directly from within the unit, by connecting to it a video
monitor equipped with HDMI input and then using a USB keyboard; a desktop environment
is also available, although this is not particularly necessary;
Note: when connecting a video monitor, the joystick interface must be turned ON after
connecting the HDMI cable (or restart/reset, if already ON), else the monitor output
circuit will not initialize.
or
2. using a serial terminal from a nearby computer, by means of the ‘RPi Console’ Mini USB
connector and a USB port on that computer;
or
3. using a SSH client from a remote computer, via network connection; a remote desktop
environment is also available over the network, although this is not particularly necessary.
The methods 1. & 2. are suitable – or even mandatory – when configuring the JOyVerride interface
IP address for the first time on a given network. Once set the IP address set, however, method 3.
might be the most appropriate.

Using method #1 – direct monitor connection
Assuming a monitor is connected to the HDMI port and a keyboard to one of the USB ports, using a
command line should be straightforward: wait for the boot ot sequence (which should last no more
than about 30 seconds) and next follow the configuration steps as described in chapter (iii).

In order to enter the desktop (once logged in), enter startx – in which case a mouse connected to one
of the USB ports is also required (except the case in which the keyboard also includes a touchpad).
While in desktop mode, a command line can be launched and used, but the Geany Programmer’s
Editor can be used for GPI inputs configuration file as well.
For using Geany editor:
•

•

click the Geany editor shortcut
if already on desktop
or
click the Raspberry Pi icon
on taskbar > Programming > Geany Programmer’s Editor;
Geany menu > File > Open... > browse to Home > .bmd > select file joy_bmd_vh.ini > click
Open
or
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click the File Manager icon
on taskbar > click .bmd folder > drag & drop the file
joy_bmd_vh.ini over the already opened Geany editor window;
Note: in case the folder .bmd is not visible in File Manager, press Ctrl+H or go to File
Manager menu > View > Show Hidden to toggle the visibility of the hidden files.
•
•

edit the file as described in chapter (iii);
save the file by overwriting the old one & eventually close Geany editor.

Using method #2 – connect via serial terminal
If using Microsoft Windows, a serial client is required on the machine from which the remote
connection is made, with PuTTY 4 being a recommended option. RealTerm 5 is also suitable,
although this one requires some skills for using it efficiently.
A proper USB drivers may be required for the FT230XS-R chipset. Assuming using PuTTY on
Windows, here is an example:
(prerequisites)
•

•

before connecting the USB cable to the unit:
◦ in Windows of the remote PC, go to Device Manager and expand the ‘Ports (COM and
LPT)’ category;
◦ notice there the existing ports
◦ leave the Device Manager window open
now connect the unit to a USB port on the remote PC, using the supplied (or other similar)
USB A <> Mini USB cable;
◦ the PC may prompt to install the drivers – and it may not find them right away; if so, a
new item ‘USB Serial Port’ with a yellow mark should appear under category ‘Other
devices’; if, after a while, Windows will not install the drivers automatically (in which
case the new item with yellow mark may display ‘FT230X Basic UART’ and that’s it),
then the drivers have to be installed manually:
▪ go to https://www.ftdichip.com/Drivers/VCP.htm;
▪ download the drivers suitable for the actual processor architecture;
▪ extract somewhere the files from the downloaded .zip archive;
▪ double-click the yellow-marked item, go to the Driver tab and follow the standard
procedure for installing a driver, pointing to the drivers from the fresh downloaded
and unzipped archive;
◦ look back at the Device Manager under the ‘Ports (COM and LPT)’ category and notice
the COM number of the USB serial port that popped up after connecting the USB cable.

(actual connection)
•
•
4
5

open PuTTY;
select the ‘Serial’ radio button;

https://www.putty.org/
https://sourceforge.net/projects/realterm/
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•
•
•
•
•
•

enter COMx in the ‘Serial line’ field, where x is the COM number as learned from the
previous prerequisites step;
specify 115200 in the ‘Speed’ field;
(optional) enter some name in the ‘Saved Sessions’ field and then click the ‘Save’ button;
◦ when connecting the next time using the same settings, just double-click over the saved
name;
click the ‘Open’ button;
◦ a blank & black terminal window will open;
press the Return key once;
◦ the prompt ‘joyverride-20i-bmd login: █’ will appear;
next follow the configuration steps as described in chapter (iii).

This is how a serial connection with PuTTY should look like:

Example for a serial connection with PuTTY (main successive steps).
The blank terminal window is normal, just press the Return key to reveal the prompt.

Using method #3 – connect via SSH
If using Microsoft Windows, a SSH client is required on the machine from which the remote
connection is made, with (again) PuTTY being a recommended option, or Bitvise SSH Client 6 also
as another good option.
Assuming using PuTTY on Windows, here is an example:
•
•
•
•
•
•

open PuTTY;
select the ‘SSH’ radio button;
enter the IP address of the JOyVerride interface in the ‘Host Name (or IP address)’ field;
(optional) enter some name in the ‘Saved Sessions’ field and then click the ‘Save’ button;
◦ when connecting the next time using the same settings, just double-click over the saved
name;
click the ‘Open’ button;
◦ a black terminal window will open with the prompt ‘login as: █’;
next follow the configuration steps as described in chapter (iii).

This is how a SSH connection with PuTTY should look like:
6

https://www.bitvise.com/ssh-client
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Example for a SSH connection with PuTTY (main successive steps).

TightVNC remote desktop server is installed by default, but must be initialized after each boot. To
do that:
•
•

•

open a terminal window (if not already open) and use the current credentials to login (if not
already logged in);
enter vncserver :X -geometry hhhhxvvvv -depth 24 where:
◦ ‘X’ is the X desktop number
◦ ‘hhhh’ is the horizontal resolution of the monitor of the remote machine
◦ ‘vvvv’ is the horizontal resolution of the monitor of the remote machine
(optional) enter exit to logout from current terminal.

Examples:
vncserver :0 -geometry 1360x768 -depth 24
> this will set X desktop as 0 and will set the virtual desktop resolution to 1360x768
vncserver :1 -geometry 1920x1080 -depth 24
> this will set X desktop as 1 and will set the virtual desktop resolution to 1920x1080
vncserver :0 -geometry 1920x1200 -depth 24
> this will set X desktop as 0 and will set the virtual desktop resolution to 1920x1200
It is recommended to use TightVNC as remote client, but other VNC clients may work properly as
well.
The default password for the VNC server is the same as the one for terminal (passwords are
independent of each other, only they have been set the same). Only the primary password is set, i.e.
the one for normal use, but not the other for view-only. To change the VNC password(s):
•
•

open a terminal window (if not already open) and use the current credentials to login (if not
already logged in);
enter vncpasswd
◦ type and retype the password for normal use
◦ either skip or type the password for view-only
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(v) Technical summary
The JOyVerride is an interface providing a “Joystick Override” video switching mode for camera
colour matching & technical control. Model 20i-BMD is designed to work in conjunction with
Blackmagic Design (BMD) Videohub Router series.
The joystick override mode allows the camera technical operator to momentary override a video
router source selection, when keep pressing the joystick (iris control lever) on the camera remote
control panel 7 (RCP) 8 – or other dedicated switch used for same purpose. After the joystick is
released, the video router source returns to the one that was last selected prior to the joystick press.
Several quasi-simultaneous joystick presses are served in a first-in / last-out stacked order.
There are 20 GPI inputs available, such that a maximum of 20 contact closures from 20 joystick
camera RCPs can be connected to it. Any GPI input can be configured to address any particular
video router output, so that an arbitrary number of video router sources can be grouped to serve an
arbitrary number of video router destinations – useful, for example, when a single video router is
used by two or more camera operators, each one operating a group of camera RCPs on their own
video control monitor.
The GPI inputs are isolated with optocouplers, with each input tied to an internal floating +5V
supply by means of 470Ω pull-up resistors. All GPI inputs share a common floating 0V rail to
which each contact must be closed.
Note: while all GPI inputs and the 0V rail are isolated and floating, the metallic case of the
DB-25 connector is NOT isolated, being always connected to the system earth ground (⏚)
together with the entire enclosure.
The connection from the joystick interface to the video router itself is done via Ethernet. No
additional equipment is required during normal operation.
Matter of fact, the joystick interface acts quite similar to a native remote control panel, with the
difference that it takes into account the order of “keys” pressed & released and that it retains the
initial router source to which it returns when the last “key” is released.
Note: until at least version 1.7 of the JOyVerride software, latching video router source
selection from a joystick contact closure (i.e. non-return to initial router source) has not yet
been considered for implementation.

7
8

True on remote control panels where an electrical contact closure is explicitly provided for this function.
Depending on manufacturer, the same camera remote control product category may have different names and
abbreviations – eg. remote control panel (RCP), operational control panel (OCP), remote control unit (RCU), etc.
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Front & rear panel layout

Connected to Vid.hub
192.168.1.156

J O y Verride
JOyVerride
20 i-BMD
Joystick
20 i-BMD
Override GPI Input
POWER

Joystick Override GPI Input

Magic Fox Media

Items on the front panel (from left to right):
•
•
•

multicolour LED, used as power ON indicator and also for connection status;
informative alphanumeric LCD display, with white LED illuminated background;
multipurpose button, used for IP/MAC address display (short press), application quit (5
seconds press) or hardware reset (over 10 seconds press).

GPI inputs 1 to 20 are pins 10-3 & 25-14
GPI common 0V is on pins 1-2 & 11-13

RPi HDMI Output
RPi Console

JOyVerride 20i-BMD
Joystick Override GPI Input Interface
Designed to operate in conjunction with BMD Videohub Routers
All inputs are optocoupler isolated
All inputs have 470Ω pull-up to internal floating +5V

Ethernet
(10/100Mbps

USB 2.0

USB 2.0

20 GPI Inputs

Voltage range:
100~240VAC
50-60Hz
25W max.

I
O

Produced by Magic Fox Media s.r.l.
Made in Romania

Items on the rear panel (from left to right, as viewed from rear):
•
•
•
•
•
•
•
•
•

fan;
HDMI monitor output connector;
USB Mini-B serial terminal connector;
Ethernet connector;
4 × USB Type A peripherals connector;
DB-25 GPI inputs connector;
fuse socket;
mains ON/OFF switch;
IEC mains input connector.
Note: units delivered to European market have red illuminated ON/OFF power switch.
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Specifications
Number of GPI inputs
GPI inputs connector
GPI input electrical characteristics
(each input)

Controller
Built-in network connection
Terminal port
Peripheral ports
Monitor output
Cooling
Fan noise
Fan life expectancy
Storage ambient temperature
Operating ambient temperature
Power input
Power voltage

Power consumption
Dimensions
Weight
Environment compliance

9

20
DB-25 female connector on panel
Optocoupler isolated;
Optocouplers inputs are connected to an internal floating
+5V supply via 470Ω pull-up resistors;
Contact closure goes to a floating common 0V rail, with
8mA (typ.) flow current per closed contact;
Note: the metallic case of the DB-25 connector is NOT
isolated, being always connected to the system earth
ground (⏚) together with the entire enclosure
Raspberry Pi 2 Model B, running Raspberry Pi OS
10/100 base-T Ethernet, Auto-MDI/X enabled
USB Mini-B connector, serial protocol, 115200, 8N1
4×USB 2.0 Type A connectors 9
HDMI (rev. 1.3 & 1.4) connector, resolutions from
640×350 to 1920×1200 pixels
Fan forced ventilation, air direction from left side to
rear-right (when viewing the unit from front)
23dB(A)
(fan manufacturer specification)
60000 hours @ 40°C, 65% humidity, 90% CL
(fan manufacturer specification)
-20°~70°C
0°C~40°C long term, -10°C~50°C fault tolerance
IEC 60320-1 C14 type connector;
ON/OFF switch at the rear side of the unit
100~240VAC voltage range to ensure EMC safety
regulations, -10% +6% fault tolerance;
50~60Hz frequency range, ±5% tolerance
Less than 25W
1U rack sized front panel, 427.9mm×120mm×37.3mm
actual case (excluding case assembly screws)
2.3kg approx.
Class A digital device – to be used only in commercial
and industrial environments

For more info regarding the USB electrical specifications and recommended peripherals, please consult the
Raspberry Pi Model 2B documentation and associated general information available on the internet.
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(vi) Appendix
GPI input connector pinout:

DB-25 connector;
panel connector is female

pin
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
16
18
19
20
21
22
23
24
25

function
Common 0V
GPI IN 8
GPI IN 7
GPI IN 6
GPI IN 5
GPI IN 4
GPI IN 3
GPI IN 2
GPI IN 1
Common 0V
GPI IN 20
GPI IN 19
GPI IN 18
GPI IN 17
GPI IN 16
GPI IN 15
GPI IN 14
GPI IN 13
GPI IN 12
GPI IN 11
GPI IN 10
GPI IN 9

All pins are electrically isolated and floating.
Outer shield of the DB-25 connector is always connected to the system earth ground (⏚), together
with the entire metallic case.
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© 2015-2020 Magic Fox Media s.r.l.
Features, design and specifications are subject to change without notice.
The most up-to-date product documentation can be found at:
https://www.magicfoxmedia.ro/index.php/products/joyverride/features/details
The most up-to-date software version can be found at:
https://www.secarica.ro/index.php/technical/joyverride#srccd
For technical support, please use this e-mail address:
support@magicfoxmedia.ro
Document rev. D
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